Services & Support
1-800-267-4878
General Caution
--------------Please use a USB Memory Stick for firmware updates.
If there is a firmware update question, please contact Anritsu service support at
https://www.anritsu.com/test-measurement/contact-us for further information.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package
: V4.50
Release Date
: Release Aug. 2022
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - DMR2
[SPH-5000] Added signal generator Board ID to the S412E Application Self Test output.
-> Software - NBFM
[SPH-5000] Added signal generator Board ID to the S412E Application Self Test output.
-> Software - NXDN
[SPH-5000] Added signal generator Board ID to the S412E Application Self Test output.
-> Software - P25/P25p2
[SPH-5000] Added signal generator Board ID to the S412E Application Self Test output.
-> Software - PTC
[SPH-5000] Added signal generator Board ID to the S412E Application Self Test output.
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-> Software - TETRA
[SPH-5000] Added signal generator Board ID to the S412E Application Self Test output.
-> Software - dPMR
[SPH-5000] Added signal generator Board ID to the S412E Application Self Test output.

*** IMPROVEMENTS ***
-> Software - CAA
[SPH-5066] Added new Time Delay measurement in the DTF measurement screen (-S33xE -MT821xE -MW82119B). When a marker is used it will display both the DTF information
and the Time Delay information. The Time Delay information will also display on the left-hand side and is also available within the marker table.
[SPH-5080] Added 4 additional cables to the standard cable list suite. -ACC014J50 (1/4) -AC012J50 (1/2) -AT078J50 (7/8) -AT114J50 (1 ¼).
-> Software - VNA
[SPH-5080] Added 4 additional cables to the standard cable list suite. -ACC014J50 (1/4) -AC012J50 (1/2) -AT078J50 (7/8) -AT114J50 (1 ¼).

*** BUG FIXES ***
-> Software - DMR2
[SPH-5046] Fixed S412E Tx Output Level value mismatch after measurement is saved or recalled in Watts.
[SPH-5071] Resolved an issue where S412E Tx Output Level unit in Volts did not recall correctly from a measurement file.
-> Software - LTE
[SPH-4943] Fixed issue where transient messages will not clear and continue to stack up. One on top of the other while in single sweep.
[SPH-5051] Fixed issue with RSRQ LTE Measurement in MS2720T.
-> Software - NBFM
[SPH-5046] Fixed S412E Tx Output Level value mismatch after measurement is saved or recalled in Watts.
[SPH-5071] Resolved an issue where S412E Tx Output Level unit in Volts did not recall correctly from a measurement file.
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-> Software - NXDN
[SPH-5046] Fixed S412E Tx Output Level value mismatch after measurement is saved or recalled in Watts.
[SPH-5071] Resolved an issue where S412E Tx Output Level unit in Volts did not recall correctly from a measurement file.
-> Software - P25/P25p2
[SPH-4938] Fixed issue where the S412E CW generator FM deviation was not working.
[SPH-5046] Fixed S412E Tx Output Level value mismatch after measurement is saved or recalled in Watts.
[SPH-5071] Resolved an issue where S412E Tx Output Level unit in Volts did not recall correctly from a measurement file.
-> Software - PDT
[SPH-5071] Resolved an issue where S412E Tx Output Level unit in Volts did not recall correctly from a measurement file.
-> Software - PIM
[SPH-4978] Resolved issue where changes to default parameters on the PIM Hunting application are not maintained when leaving mode or when unit is turned off.
-> Software - PTC
[SPH-5046] Fixed S412E Tx Output Level value mismatch after measurement is saved or recalled in Watts.
[SPH-5071] Resolved an issue where S412E Tx Output Level unit in Volts did not recall correctly from a measurement file.
-> Software - SPA and Sub-apps
[SPH-4938] Fixed issue where the S412E CW generator FM deviation was not working.
-> Software - TETRA
[SPH-5046] Fixed S412E Tx Output Level value mismatch after measurement is saved or recalled in Watts.
[SPH-5071] Resolved an issue where S412E Tx Output Level unit in Volts did not recall correctly from a measurement file.
[SPH-5082] Fixed issue in the S412E where the fm_1kHz_audio pattern does not work after a custom DL pattern is loaded or deleted.
-> Software - dPMR
[SPH-5046] Fixed S412E Tx Output Level value mismatch after measurement is saved or recalled in Watts.
[SPH-5071] Resolved an issue where S412E Tx Output Level unit in Volts did not recall correctly from a measurement file.
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________________________________________________________________________________
What will the customer see in this release?
Product
: S412E, MW82119B
Application Package
: V4.40
Release Date
: Release Nov. 2021
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - TETRA
[SPH-4509] Added a new feature to allow users the ability to load custom TETRA DL test patterns.
-> Software - NBFM
[SPH-4988] Added dBuV units to EMF measurement in NBFM analyzer mode for S412E.

*** IMPROVEMENTS ***
-> Software - DMR2
[SPH-5029] Default squelch level changed from -100 dBm to -110 dBm across all LMR applications to better suit the general customer needs.
-> Software - NXDN
[SPH-5029] Default squelch level changed from -100 dBm to -110 dBm across all LMR applications to better suit the general customer needs.
-> Software - dPMR
[SPH-5029] Default squelch level changed from -100 dBm to -110 dBm across all LMR applications to better suit the general customer needs.
-> Software - NBFM
[SPH-5029] Default squelch level changed from -100 dBm to -110 dBm across all LMR applications to better suit the general customer needs.
-> Software - TETRA
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[SPH-5029] Default squelch level changed from -100 dBm to -110 dBm across all LMR applications to better suit the general customer needs.
-> Software - P25/P25p2
[SPH-5029] Default squelch level changed from -100 dBm to -110 dBm across all LMR applications to better suit the general customer needs.
[SPH-5034] Resolved an issue where the P25 LSM Tx pattern output levels were lower than the selected value.
-> Software - CAA
[SPH-5041] Added the AFW-2HFR-3 7/8 inch fire rated cable to the Anritsu cable list. This fire rated cable has been introduced to support the new public safety indoor signal
coverage requirements.
-> Software - PTC
[SPH-5029] Default squelch level changed from -100 dBm to -110 dBm across all LMR applications to better suit the general customer needs.
-> Software - PDT
[SPH-5029] Default squelch level changed from -100 dBm to -110 dBm across all LMR applications to better suit the general customer needs.

*** BUG FIXES ***
-> Software - DMR2
[SPH-5020] Resolved an issue where Tx Output units did not convert correctly between Volts and Watts when output power was set to greater than -0.9dBm.
-> Software - NXDN
[SPH-5020] Resolved an issue where Tx Output units did not convert correctly between Volts and Watts when output power was set to greater than -0.9dBm.
-> Software - dPMR
[SPH-5020] Resolved an issue where Tx Output units did not convert correctly between Volts and Watts when output power was set to greater than -0.9dBm.
-> Software - PIM
[SPH-4976] Fixed an issue with saved Noise Floor-Spectrum view plots that previously could not be opened by Line Sweep Tools (LST).
[SPH-5027] Fixed an issue that could cause a unit to freeze while switching between the Cable & Antenna measurement mode and PIM measurement mode.
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-> Software - TETRA
[SPH-4998] Resolved an issue in which the soft buttons would not respond after aborting a TETRA pattern load by pressing the ESC button.
[SPH-5020] Resolved an issue where Tx Output units did not convert correctly between Volts and Watts when output power was set to greater than -0.9dBm.
[SPH-5032] Resolved an issue when loading a custom TETRA DL pattern from USB device. Multiple key presses could result in all patterns on the USB stick being loaded.
[SPH-5033] Resolved an issue where custom TETRA patterns could be erased during firmware updates.
-> Software - NBFM
[SPH-5020] Resolved an issue where Tx Output units did not convert correctly between Volts and Watts when output power was set to greater than -0.9dBm.
-> Software - P25/P25p2
[SPH-5020] Resolved an issue where Tx Output units did not convert correctly between Volts and Watts when output power was set to greater than -0.9dBm.
-> Software - PTC
[SPH-5020] Resolved an issue where Tx Output units did not convert correctly between Volts and Watts when output power was set to greater than -0.9dBm.
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_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V4.30
Release Date
: Quarterly Release April 2021
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - PIM
[SPH-4844] Added Support for MW82119B-0703 option.

*** IMPROVEMENTS ***
-> Software - PIM
[SPH-4510] DTP overlay previously had to be re-applied/measured every time a user switched to another PIM measurement mode (Swept PIM or PIM vs. Time). with this fix the
DTP overlay will stay active between PIM measurement modes. This will save the technician time in the field since they will only need a single DTP overlay measurement per
antenna.

*** BUG FIXES ***
-> Software - CAA
[SPH-5003] Fixed an issue were the default F1 and F2 frequencies for the MW82119B-0194 model were incorrect.
[SPH-5007] Resolved an issue where setting the option 28 CWSG frequency to 3 decimal places (1 kHz resolution) resulted in the actual CW frequency being rounded to 2 decimal
places (10 kHz resolution).
-> Software - SPA and Sub-apps
[SPH-4946] Fixed an issue with functionality of the PIM hunting measurement mode when recalling a setup file.
[SPH-4948] Fixed an issue were the PIM Hunting sweep time was not matching in the status window.
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[SPH-5007] Resolved an issue where setting the option 28 CWSG frequency to 3 decimal places (1 kHz resolution) resulted in the actual CW frequency being rounded to 2 decimal
places (10 kHz resolution).
-> Software - PIM
[SPH-4674] Fixed an issue where the MW82119B-0700 PIM Master was not remembering non-default F1 and F2 settings.
[SPH-4954] Fixed an issue were user defined F1 and F2 values and calibration were lost going between High band and Low band in the MW82119B-0700 700 MHz PIM Master. The
unit will now remember both the F1 and F2 values and the calibration between High band and Low band.
[SPH-4968] Resolved an issue when using the SCPI command (programming language) to recall the residual PIM value returning the wrong value.
[SPH-4975] Fixed an issue were the residual PIM calibration was not applied to F2 on the MW82119B-0700/-0701 PIM Master models at 20W with the Swept PIM measurement.
[SPH-4977] Fixed an issue in the MW82119B-0700 model that was setting the wrong IM range for Swept PIM measurements after the user makes PIM vs. Time measurements in
both Low Band and High Band before making a swept PIM measurement.

_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V4.20
Release Date
: Quarterly Release Jan. 2021
Information below may not apply to every model/option in Product list

*** IMPROVEMENTS ***
-> Software - PIM
[SPH-4510] DTP overlay previously had to be re-applied/measured every time a user switched to another PIM measurement mode (Swept PIM or PIM vs. Time). with this fix the
DTP overlay will stay active between PIM measurement modes. This will save the technician time in the field since they will only need a single DTP overlay measurement per
antenna.

*** BUG FIXES ***
-> Software - SPA and Sub-apps
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[SPH-4939] Fixed an issue in PIM Hunting mode when a user changed the default settings the unit did not remember the last settings.
[SPH-4947] Fixed an issue where the PIM Hunter Menu button would show up in IA mode of operation.
[SPH-4950] Fixed a problem when switching between PIM Analyzer mode (1st generation/legacy PIM Master receiver mode) and PIM Hunting mode in our spectrum analyzers.
The sweep in PIM Hunting mode stopped and the left side parameters were not reset.
[SPH-4952] Fixed an issue in PIM Hunting mode. When manually changing the span (normal spectrum analyzer function) and resetting to Zero span or using last span. PIM Hunting
mode would not restart. PIM Hunting mode is a Zero Span measurement.
[SPH-4983] Fixed an issue in PIM Hunting mode under certain conditions when switching from PIM Hunting mode to another measurement mode (ie. LTE) the unit would freeze
up or reboot.
[SPH-4984] Fixed an issue when in PIM Hunting mode the sweep would slow down if power cycled or switched back and forth between other modes.
-> Software - PIM
[SPH-4674] Fixed an issue where the MW82119B PIM Master was not remembering non-default F1 and F2 settings.
[SPH-4954] Fixed an issue were user defined F1 and F2 values and calibration were lost going between High band and Low band in the MW82119B-0700 700 MHz PIM Master. The
unit will now remember both the F1 and F2 values and the calibration between High band and Low band.
[SPH-4958] Fixed an issue in PIM Hunting mode when the 1 KHz RBW was used the trace sweep would stop.
[SPH-4968] Resolved an issue using the SCPI command (programming language) to recall the residual PIM value returned the wrong value.
[SPH-4986] Fixed an issue in PIM Hunting mode when the 1 KHz RBW was used the trace sweep would stop.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T
Application Package: V4.00
Release Date
: Quarterly Release Sept. 2020
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - SPA and Sub-apps
[SPH-4917] Resolved an issue where it was not possible to set Zero Span time markers to negative values remotely. This change applies only to Spectrum Analyzer (SPA) modes.
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*** IMPROVEMENTS ***
-> Software - SPA and Sub-apps
[SPH-4809] Added .csv file save format for the Cable/Antenna analyzer (CAA) measurements.

*** BUG FIXES ***
-> Software - CAA
[SPH-4935] In response to numerous customer requests, dual trace .dat measurement files will no longer result in 2 individual files saved. Dual trace .dat measurement files saved
are fully compatible with Line Sweep Tools (LST). This change affects the Cable/Antenna analyzer (CAA) mode only.
[SPH-4936] Fixed an issue in PIM Hunting mode when the RBW was set at 1 KHz the sweep could freeze.
[SPH-4937] Fixed an issue were the attenuation level was changing based on the Reference Level setting. For the PIM Hunting application this behavior has been changed so that
the value stays the same and the default is 0 dB attenuation.
[SPH-4957] Resolved an issue where certain combinations of start/stop frequency and number of data points could result in spikes appearing after calibration.
-> Software - SPA and Sub-apps
[SPH-4949] Fixed an issue were the Spectrum graph in PIM Hunting measurement covered the Center Frequency as well as Span and other annotations in (ms/s) after switching
mode from SPA PIM Hunting to AM-FM-PM => PIM Analyzer => Spectrum Analyzer.
-> Software - VNA
[SPH-4830] Resolved an issue where recalling a [Trace + Memory]/2 measurement resulted in the Trace Math function being re-applied.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V3.90
Release Date
: Release May. 2020
Information below may not apply to every model/option in Product list

*** IMPROVEMENTS ***
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-> Software - CAA
[SPH-2095] The following cables have been added per customer requests: RLCX-SL 158R, RLCX-SL 114R, RLCX-SL 078R, RLCX-SL012R, RLCX-SL038R, RLCX-SL014R, RLCX-SL012S,
RLCX-SL038S, RLCX-SL014S, RLCX-SL012R FPR.
[SPH-4778] CSV file format added to File Save Menu.
-> Software - VNA
[SPH-2095] The following cables have been added per customer requests: RLCX-SL 158R, RLCX-SL 114R, RLCX-SL 078R, RLCX-SL012R, RLCX-SL038R, RLCX-SL014R, RLCX-SL012S,
RLCX-SL038S, RLCX-SL014S, RLCX-SL012R FPR.

*** BUG FIXES ***
-> Software - CAA
[SPH-4731] Resolved an issue where sometimes the last point marker value displayed would not match the last point data in the saved measurement.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V3.80
Release Date
: Release Jan. 2020
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - LTE
[SPH-4852] Adding initial support for TD-LTE measurements for S412E.
-> Software - PIM
[SPH-4844] Added Support for MW82119B-0703 option.
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-> Software - OS/Base
[SPH-4806] Added support for amplitude blanking capability in S11 and S21 Log Mag graph types only, for models with option 007 installed.
-> Software - SPA and Sub-apps
[SPH-4808] New PIM Hunting mode, used for PIM Hunting applications on rooftops with the PIM Hunting probe or Yagi antennas.

*** BUG FIXES ***
-> Software - P25/P25p2
[SPH-4884] Corrected an error on the Band plan. The frequency and channel numbers for P25 will now be correct.
-> Software - PTC
[SPH-4798] Improved Trigger Timeout message responsiveness.
-> Software - VNA
[SPH-4760] Resolved an issue in VNA Mode where saving a measurement + JPG could result in repeated file confirmation messages.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V3.70
Release Date
: Quarterly Release October 2019
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - CAA
[SPH-4784] Added (Trace + Memory)/2 feature to Trace Memory. Allows users to reduce or eliminate peak-to-peak ripple caused by standing waves when making 1-port cable loss
measurements.
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*** BUG FIXES ***
-> Software - DMR2
[SPH-4000] regional language Support for S412E LMR Master is available.
-> Software - NXDN
[SPH-4000] regional language Support for S412E LMR Master is available.
-> Software - dPMR
[SPH-4000] regional language Support for S412E LMR Master is available.
-> Software - NBFM
[SPH-4000] regional language Support for S412E LMR Master is available.
-> Software - TETRA
[SPH-4000] regional language Support for S412E LMR Master is available.
[SPH-4690] Fixed an issue where TETRA Base Station Receiver Sensitivity loading of customer patterns did not operate correctly. Added a softkey to display BCC, MCC, and MNC of
loaded BSRS custom patterns.
-> Software - P25/P25p2
[SPH-4000] regional language Support for S412E LMR Master is available.
-> Software - PTC
[SPH-4000] regional language Support for S412E LMR Master is available.
-> Software - PDT
[SPH-4000] regional language Support for S412E LMR Master is available.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
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Application Package: V3.60
Release Date
: Quarterly Release August 2019
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - DMR2
[SPH-4680] Add new MS 1031 5% BER signal pattern to DMR Analyzer.
-> Software - PTC
[SPH-4721] Rename Options 721 and 722 from PTC" to "PTC-ITCR"."
[SPH-4723] Added remote commands for PTC-ACSES
[SPH-4724] Added PTC-ACSES save/recall setups and measurements.
[SPH-4726] New PTC-ACSES graph implementation.
[SPH-4727] New PTC-ACSES icon.
-> Software
[HHMP-21] Added DMR MS 1031 5% BER pattern.
[HHMP-78] Released options 731 and 732, PTC-ACSES Analyzer and Coverage Mapping.

*** IMPROVEMENTS ***
-> Software - CPRI
[SPH-4766] Added BBU Emulation script support for Nokia/ALu radios RRH4x45-1900 and R2x50-80L1.

*** BUG FIXES ***
-> Software
[HHMP-245] Rename Options 721 and 722 from PTC" to "PTC-ITCR"."
Copyright© ANRITSU. All rights reserved.

Services & Support
1-800-267-4878
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T
Application Package: V3.50
Release Date
: Quarterly Release April 2019
Information below may not apply to every model/option in Product list

*** IMPROVEMENTS ***
-> Software - CPRI
[SPH-4627] Added Samsung and Huawei to PIM Aid radio preset selections.

*** BUG FIXES ***
-> Software - SPA and Sub-apps
[SPH-4691] Fixed an issue where field strength measurement settings might not properly apply after power cycle.
-> Software - OS/Base
[SPH-4617] Fixed an issue in S412E where setting the Input Power Warning to ON would prevent the 'available firmware update message' from displaying when appropriate
during power-up.
[SPH-4713] Fixed an issue where automatic firmware updates would not execute in S412E under some circumstances.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
Application Package: V3.41
Release Date
: Release Patch March 2019
Information below may not apply to every model/option in Product list
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*** BUG FIXES ***
-> Software - TETRA
[SPH-4729] - Fixes an issue where the Tetra BSRS patterns might not play back correctly.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V3.40
Release Date
: Quarterly Release January 2019
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - CAA
[SPH-4535] Added cal coefficient support for cal kits with 4.3-10 connectors.
-> Software - PTC
[SPH-4442] Added common American Association of Railroads (AAR) frequency standards to our Signal Standards lists, and made them available in PTC mode.
-> Software - SPA and Sub-apps
[SPH-4566] Added dBuW, dBmA, and dBuA units in SPA mode.
-> Software - VNA
[SPH-4535] Added cal coefficient support for cal kits with 4.3-10 connectors.

*** IMPROVEMENTS ***
-> Software - LTE
[SPH-4590] Added Band 71, the new 600 MHz LTE Band to the signal standard list.
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*** BUG FIXES ***
-> Software - LTE
[SPH-4597] Fixed an issue where recalled 4x4 MIMO LTE measurement would not properly display the green/grey antenna icons.
-> Software - ISDBT/SFN
[SPH-4687] Corrected the antenna.txt file so that it would behave correctly in ISDB-T mode.
-> Software - VNA
[SPH-4689] Fixed an issue in field mode that unnecessarily limited scale settings in Field Mode VSWR measurements.
-> Software - SPA and Sub-apps
[SPH-3745] Fixed a corner case error with averaging in Interference Analysis Field Strength measurement.
[SPH-4458] Antenna selection list now includes EMI antennas when 'All' is selected.
-> Software - PIM
[SPH-4642] Changed the time/date text layout in the PIM Calibration Due popup.
[SPH-4644] Addressed an issue that could cause an option 600 or 902 instrument to lock up when they are set to high band and perform a calibration via the SCPI command:
CAL:PIM:FULL ON
-> Software - OS/Base
[SPH-4593] Fixed an issue where unit would hang during power-up under certain conditions after recalling a VNA setup from SPA mode.
-> Software - CAA
[SPH-4593] Fixed an issue where unit would hang during power-up under certain conditions after recalling a VNA setup from SPA mode.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V3.30
Release Date
: Quarterly Release October 2018
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Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - TETRA
[SPH-3853] External - Used Training Sequence symbols to determine BER for both allocated and unallocated signal bursts.

*** BUG FIXES ***
-> Software - ISDBT/SFN
[SPH-3731] Fixes an issue where over a 100 ISDBT files were saved into a folder which resulted in the unit slowing down in time. Files are now saved in multiple folders with date
and timestamp.
-> Software - VNA
[SPH-4026] Fixes an issue where the application would hang in Transmission Measurement mode when recalling a set up file to put the unit into Cable and Antenna Analyzer
Mode, and then attempting to run an OSL calibration.
[SPH-4028] Fixes an issue where the SPA Amplitude Menu would show up in Transmission Measurement Mode.

[SPH-4605] Fixed an issue in VNA mode where glitches would appear at 375MHz and 1500 MHz after a calibration.
-> Software - SPA and Sub-apps
[SPH-3745] Fixed a corner case error with averaging in Interference Analysis Field Strength measurement
[SPH-3951] Disabled the use of Start Freq and Stop Freq in Interference Analysis mode. Center Freq is the proper way to set frequency in this mode.
[SPH-4547] Fixed an issue with field strength limits under V/m units setting
-> Software - TETRA
[SPH-3570] Fixed a bug in TETRA where some units would not recall the correct Tx Output pattern as part of a recalled measurement or setup
[SPH-3943] Fixed an issue in TETRA app where recalling a measurement or setup would not correctly recall the Tx pattern.
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-> Software - OBSAI
[SPH-3738] Fixed an issue where the system time would not recall properly under some saved measurement conditions
-> Software - CPRI
[SPH-3738] Fixed an issue where the system time would not recall properly under some saved measurement conditions
_________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
Application Package: V3.24
Release Date
: Quarterly Release September 2018
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - TETRA
[SPH-3853] External - Used Training Sequence symbols to determine BER for both allocated and unallocated signal bursts.

*** BUG FIXES ***
-> Software - CAA
[SPH-4624] Fixes an issue where running a self-test upon entry to PTC mode would result in a hang.
-> Software - PTC
[SPH-3941] Fixed an issue where the CW pattern in PTC mode would sometimes output more power than the UI setting indicated.
[SPH-4624] Fixes an issue where running a self-test upon entry to PTC mode would result in a hang.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Copyright© ANRITSU. All rights reserved.
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Application Package: V3.20
Release Date
: Quarterly Release beginning July 2018
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - TETRA
[SPH-4471] Motorola EBTS added to Base Station Selections in Tetra Base Station Sensitivity Tests
-> Software - NB-IoT
[SPH-4569] Fixes an issue where performing a preset does not set the center frequency of the analyzer correctly. Similar behavior can be noticed during setup and measurement
recall.
-> Software - PIM
[SPH-4546] Changed the default F2 frequencies for Option 700 to 764 / 761 MHz for low / high band, respectively.
-> Software - OS/Base
[SPH-4429] Improved battery charge algorithm.

*** BUG FIXES ***
-> Software - DMR2
[SPH-3621] Fixes an issue where the Back soft button is inactivated incorrectly after pressing Max/Min Active Graph soft button
[SPH-3797] Fixes an issue where ENTER button from keypad to collect new data points from Coverage Mapping doesn't work.
-> Software - NXDN
[SPH-3797] Fixes an issue where ENTER button from keypad to collect new data points from Coverage Mapping doesn't work.
-> Software - VNA
[SPH-4504] Fixes an issue where in Dual Channel mode, the Smith Chart marker table TR1 and TR2 readout text would overwrite each other.
Copyright© ANRITSU. All rights reserved.

Services & Support
1-800-267-4878
-> Software - dPMR
[SPH-3797] Fixes an issue where ENTER button from keypad to collect new data points from Coverage Mapping doesn't work.
-> Software - OS/Base
[SPH-4426] Fixed the issue where saving files to a USB memory via the MMEMory:STORe:JPEG command failed when the usr folder was not present in the USB memory.
-> Software - TETRA
[SPH-3797] Fixes an issue where ENTER button from keypad to collect new data points from Coverage Mapping doesn't work.
-> Software - NBFM
[SPH-3797] Fixes an issue where ENTER button from keypad to collect new data points from Coverage Mapping doesn't work.
-> Software - P25/P25p2
[SPH-3797] Fixes an issue where ENTER button from keypad to collect new data points from Coverage Mapping doesn't work.
-> Software - PTC
[SPH-3797] Fixes an issue where ENTER button from keypad to collect new data points from Coverage Mapping doesn't work.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S412E, MS202xB, MS203xB, MS202xC, MS203xC, MW82119B
Application Package: V3.10
Release Date
: Quarterly Release beginning April 2018
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - GSM/EDGE
[SPH-3938] Added option 880, GSM/EDGE Signal Analyzers to model S412E
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-> Software - LTE
[SPH-4436] Change MIMO auto detect threshold in LTE and TD-LTE applications, so that the unit is less likely to assume that noise is another active antenna.
-> Software - dPMR
[SPH-1520] Enables NXDN_4800 O.153 pattern in dPMR

*** BUG FIXES ***
-> Software - DMR2
[SPH-3316] Fixed an issue where mapping data points could unexpectedly persist between applications.
-> Software - LTE
[SPH-3833] Fixed an issue where values for PHICH and PDCCH in LTE application did not export correctly into Master Software Tools.
-> Software - NXDN
[SPH-3316] Fixed an issue where mapping data points could unexpectedly persist between applications.
-> Software - dPMR
[SPH-3316] Fixed an issue where mapping data points could unexpectedly persist between applications.
-> Software - SPA and Sub-apps
[SPH-3940] Fixed an issue in spectrum analyzer mode where adding multiple markers, and/or setting markers beyond the instrument's frequency range, could cause the
instrument to lock up.
-> Software - NBFM
[SPH-3316] Fixed an issue where mapping data points could unexpectedly persist between applications.
-> Software - OS/Base
[SPH-4360] Fixed an issue where the GPS information in the title would disappear after recalling a setup file.
-> Software - P25/P25p2
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[SPH-3316] Fixed an issue where mapping data points could unexpectedly persist between applications.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V3.00
Release Date
: Quarterly Release beginning January 2018
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - CAA
[SPH-3864] Added additional save type Measurement and JPG" to the uWave VNA family."
-> Software - PIM
[SPH-3921] PIM Measurement Tx1 range adjusted to cover 731 MHz to 734.5 MHz
-> Software - VNA
[SPH-3864] Added additional save type Measurement and JPG" to the uWave VNA family."

*** BUG FIXES ***
-> Software - VNA
[SPH-3591] Fixes an issue with Cable Loss mode where limit lines would change after a calibration was completed.
[SPH-3646] Fixes an issue where the touch screen functionality would be disabled due to the Attention" dialog moving behind the main form window."
-> Software - CPRI
[SPH-2932] Fixed an issue in single sweep CPRI Spectrogram where it would not always stop the measurement after one sweep.
[SPH-3536] Fixed an issue - Limits can now only be recalled if the limits were saved in the same mode of operation (SPA, CPRI, OBSAI) as is currently running on the unit.
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-> Software - OS/Base
[SPH-3572] Fixed an issue where the GPS tag does not disappear even though GPS is off. This would occur when recalling a trace with GPS data then switching to a live trace and
switching modes.
[SPH-3739] Fixed an issue where the unit didn't display an error message when setting the Save Location to USB, then removing the USB, and pressing the camera icon to save a
screenshot.
[SPH-3829] Fixed an issue where the option list on the boot up screen was beyond the right edge.
-> Software - OBSAI
[SPH-3536] Fixed an issue - Limits can now only be recalled if the limits were saved in the same mode of operation (SPA, CPRI, OBSAI) as is currently running on the unit.
-> Software - P25/P25p2
[SPH-3321] Fixed an issue with file format. Saving control channel files now places each group of associated data on its own line, when recalled with a text editor.
-> Software - CAA
[SPH-3646] Fixes an issue where the touch screen functionality would be disabled due to the Attention" dialog moving behind the main form window."
[SPH-3837] Fixes an issue where the Dmax value could be manually set to a value that was large then the calculated Dmax value.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T
Application Package: V2.90
Release Date
: Quarterly Release beginning October 2017
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - LTE
[SPH-3136] Added Option 886 for 256 QAM extension to FD-LTE and TD-LTE applications
[SPH-3777] Fixed an issue in TD-LTE that would cause constellation to occasionally make bad measurements on valid 256 QAM input signals. (MS2720T Only)
Fixed an issue where changing modes directly to LTE or TD-LTE after a factory default would not correctly display a 256-QAM constellation (MS2720T Only)
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[SPH-3188] Added 3GPP Release 13 Spectral Emission Masks for frequencies > 3 GHz in LTE & TD-LTE measurements.
-> Software - PIM
[SPH-3658] SPH-3658 Adds support for the SCPI command MMEMory:DELete for deleting setup and measurement files.
-> Software - VNA
[SPH-2592] Increases the number of markers from 8 to 12 in VNA mode (mwVNA Instruments, VNA and Field measurement views).

*** IMPROVEMENTS ***
-> Software - DMR2
[SPH-2941] Added remote command to maximize/minimize the active graph type. (See Programming manual for details)

*** BUG FIXES ***
-> Software - VNA
[SPH-2451] Fixes an issue where the Cable List Window was not remaining the top-most form and would move behind the VNA graph.
[SPH-2593] Changes the mwVNA Instruments Limit Line Feature such that each measurement mode can now have independent limit line settings.
-> Software - OS/Base
[SPH-3237] Fixed the issue where using the arrow keys to move around the indoor map was slow in the Spectrum Analyzer mode.
Fixed the issue where moving the cursor around the indoor map failed after recalling a AZM file.
Fixed the issue where pressing the Enter key didn't record data points in indoor map in Spectrum Analyzer mode.
-> Software - NBFM
[SPH-2811] Fixed a bug in NBFM that would cause beep with every sweep when Auto Scan is On.
-> Software - CPRI
[SPH-3029] Fixed a bug that could prevent the second waterfall graph from displaying in a Dual Display recalled spectrogram measurement.
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_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V2.80
Release Date
: Quarterly Release beginning July 2017
Information below may not apply to every model/option in Product list

*** BUG FIXES ***
-> Software - LTE
[SPH-2922] In LTE-EMF mode, when the EMF antenna is disconnected, error messages have been reorganized to have better readability.
[SPH-2924] In WCDMA-EMF mode, when the EMF antenna is disconnected, error messages have been reorganized to have better readability.
-> Software - VNA
[SPH-2594] Fixed an issue with multiple markers and touching the trace, which was causing the nearest marker to become active and move to the touched location.The new
behavior is such that touching the trace will result in the marker that is already active to move to the location that was touched.
[SPH-2595] Fixed an issue where when Marker on trace" was set to "All" (in field mode for example) the marker would not update correctly when the start or stop frequency was
changed."
-> Software - CPRI
[SPH-2708] Preset now set Spectrogram Record to 'Off' state
[SPH-2898] Starting with MST V2.36.8 and unit firmware V2.8x, MST will support multiple traces from OBSAI and CPRI applications.
[SPH-2969] Corrected preset values for limit lines in CPRI and OBSAI applications.
[SPH-2970] Fixed a bug where CPRI/OBSAI limit lines would not correctly export to Master Software Tools. Also requires MST v2.36.8
[SPH-2971] Lower Limit line default value corrected in CPRI and OBSAI to match the RF applications
[SPH-3232] Fixed a bug where internal time base would not always lock to external or GPS reference in CPRI mode
-> Software - SPA and Sub-apps
[SPH-2841] Fixes an issue where EMI antenna selection was off by one.
[SPH-3138] Fixes rounding error of BW value in Channel Scanner file after Scriptmaster scan.
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-> Software - OS/Base
[SPH-3237] Fixed the issue where using the arrow keys to move around the indoor map was slow in the Spectrum Analyzer mode. Also fixed the issue where moving the cursor
around the indoor map failed after recalling a AZM file.
-> Software - OBSAI
[SPH-2975] Fixed a bug where Single Sweep mode would occasionally cause the Layer 2 Alarms display to flicker
-> Software - P25/P25p2
[SPH-3147] Mapping data collection for is now limited to 8 hours or 60,000 points of data collection to avoid memory overrun issues.
-> Software - CAA
[SPH-2424] Fixed an issue where the unit would hang if a SCPI preset was issued and the Cable list table dialog was open.
NOTE: THIS FIX ALSO APPLIES TO THE PIM MASTER.
[SPH-2548] Fixed an issue where the marker would not move when adjusting the twiddle knob to the left.
[SPH-3114] Fixed an issue where Marker-to-Peak and Marker-to-Valley were shifted 1 pixel to the left when recall a measurement file type .dat.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
Application Package: V2.72
Release Date
: May 2017
Information below may not apply to every model/option in Product list

*** BUG FIXES ***
-> Software - DMR
[SPH-3303] Fixed an issue where the bs_1031 patterns could not generate all color codes
Fixed an issue where ms_1031 synchronization would not work for all color codes.
Customer should re-load DMR signal generator patterns with v2.72 firmware.
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_________________________________________________________________________________
What will the customer see in this release?
Product
: S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MW82119B
Application Package: V2.70
Release Date
: Quarterly Release beginning April 2017
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***

*** IMPROVEMENTS ***
-> Software - DMR2
[SPH-2156] Tx Output will now synchronize to Base Station downlink signal
-> Software - VNA
[SPH-2402] The limit line behavior in the Cable and Antenna mode of the BTS Master has been enhanced. With this update, the limit line settings for each measurement type will
be unique for that measurement and will persist even if the measurement type is changed.

*** BUG FIXES ***
-> Software - SPA and Sub-apps
[SPH-2337] Fixes an issue where Emission Mask measurements produced erroneous pass/fail results under certain conditions.
[SPH-2504] Fixed an issue where Field Strength measurements in Coverage Mapping did not display the correct results for non-dBm units
-> Software - OS/Base
[SPH-2860] Added support for commands with a block data parameter for the raw socket SCPI interface.
-> Software - TETRA
[SPH-2397] Fixed a bug where saved .mtd files were not correctly storing EVM data.
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-> Software - NBFM
[SPH-2891] Fixed a bug in NBFM where changing DCS value could corrupt the Signal Generator pattern outputs for all LMR demod applications
-> Software - CAA
[SPH-2393] Fixed an issue with the Back soft key in the Application Options menu that would not return the user back to the System Menu once they have entered into the Bias
Tee menu.
-> Software - PTC
[SPH-2455] SOURce:DM:PATTern and SOURce:DM:PATTern? remote commands are now functional
________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V2.61
Release Date
: Supplemental Release March 2017
Information below may not apply to every model/option in Product list

*** BUG FIXES ***
-> Software - TETRA
[SPH-3108] Fixed a bug that would cause the TETRA BS Sensitivity button to be invisible
-> Software - NBFM
[SPH-2892] Fixed a bug where NBFM mode could disrupt access to signal generator patterns for all LMR demodulation applications.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V2.60
Release Date
: Quarterly Release beginning January 2017
Information below may not apply to every model/option in Product list
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*** NEW FEATURES ***
-> Software - DMR2
[SPH-1811] DMR2 Application nomenclature changed to DMR" Remote command remain compatible."
-> Software - CAA
[SPH-2508] Added support for easyTest in the VNA Master (MS20xxB series) and LMR Master (S412E).
[SPH-1506] Added a SCPI command to allow saving of .dat measurement files.
-> Software - LTE
[SPH-2296] Added limited support for TD-LTE 4x4 MIMO
-> Software - VNA
[SPH-2508] Added support for easyTest in the VNA Master (MS20xxB series) and LMR Master (S412E).
[SPH-1506] Added a SCPI command to allow saving of .dat measurement files.
-> Software - CPRI
[SPH-2180] For Option 751 CPRI - Added the ability to show two spectrum or spectrogram graphs which can display up to four separate AxC groups (traces).
[SPH-2448] Added support for CPRI line rate 8 (10.1376 Gbps)
[SPH-2449] Added support for compressed LTE sampling rate on 20 MHz LTE signals
[SPH-2640] Auto Detect improved with Ericsson presets

*** IMPROVEMENTS ***
-> Software - OS/Base
[SPH-2515] Web UI tab removes model information.

*** BUG FIXES ***
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-> Software - LTE
[SPH-47] Fixed a bug in LTE EMF recalled measurements where RS values might recall improperly
[SPH-2240] Fixed an issue that prevented 4x4 MIMO time alignment data from recalling properly to unit.
[SPH-2788] Shift-1 Preset is now prevented while a recalled measurement is displayed.
-> Software - SPA and Sub-apps
[SPH-1988] Fixes a bug where the zero span max RBW value was incorrectly limited in the GUI and as a result was out of sync with the actual RBW value.
-> Software - OS/Base
[SPH-1812] Fixed an issue where black on white and color on white schemes were not displaying correctly in some LMR Master modes.
-> Software - HiPM
[SPH-1667] Fixed a bug where the unit would unexpectedly attempt to zero the sensor after recalling a measurement
[SPH-2381] Fixes an issue where the Quick name buttons were not saved with the setup in Hi-PM mode.
-> Software - TETRA
[SPH-2376] Save on Event .csv measurement files are updated to contain results for recently-added RMS Vector Error and Peak Vector Error measurements.
-> Software - VSG
[SPH-1800] BTS Master VSG now allows up to 48 waveforms to be loaded
-> Software - P25/P25p2
[SPH-2373] Fixed an issue that could cause the unit to hang when recalling setups for an application other than the current one.
[SPH-2501] Updated remote DISPlay:TRACe<Tr>:FORMat:SIGAnalyzer command/query parameters to match the Programming Manual.
-> Software - WiMAX
[SPH-2309] Fixed a bug where the unit would intermittently hang when displaying Spectral Emission Mask
_________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
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Application Package: V2.52
Release Date
: December 2016
Information below may not apply to every model/option in Product list
*** BUG FIXES ***
-> Software - LMR
[SPH-2745] Fixed an issue with V2.50 firmware where LMR patterns do not playback on some of the older S412E hardware.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, MS271xE, MT821xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MT822xB, MT8220T, MW82119B
Application Package: V2.50
Release Date
: Quarterly Release beginning October 2016
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - TETRA
[SPH-2147] Added Residual Carrier Magnitude measurement to the Summary display
[SPH-2149] TETRA remote queries :FETCh:SIGAnalyzer? :READ:SIGAnalyzer? :MEASure:SIGAnalyzer? will now contain two additional values in the response for Peak Vector Error
and Residual Carrier Magnitude
[SPH-1603] Added Police Digital Trunking Options 563 and 562
-> Software - OS/Base
[SPH-119] Improved error message on LTE trace save failure when trying to save before the end of the first sweep.
-> Software - NBFM
[SPH-1919] Remote command :FETCh:SIGAnalyzer? updated so the second returned value in the string will represent the value indicated by the Summary Freq Disp front panel
setting. (Carrier Frequency or Frequency Error)
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-> Software - VNA
[SPH-1921] Added select SCPI commands to support VNA Field Mode.

*** BUG FIXES ***
-> Software - VNA
[SPH-2307] Resolved an issue with marker interpolation on Smith Charts or Polar Charts that caused stray lines to be drawn over the entire screen. This issue only affected VNA
mode in the VNA Master products.
-> Software - SPA and Sub-apps
[SPH-282] Fixed an issue where Markers on Result traces do not jump to the right frequency when markers are toggled between traces.
[SPH-2182] In SPA field strength graph, negative antenna factors show correctly over frequency.
-> Software - OS/Base
[SPH-1642] Fixed a typo in the power limit warning message at boot.
[SPH-1653] Clearing old messages when changing modes from a recall state.
[SPH-1681] Fixed a black out of the web interface remote display in Chrome when selecting a different browser tab then selecting the remote display tab.
[SPH-1863] Fixed an issue where SPA application performed a LO Null search on the second application load after a master reset.
[SPH-1889] Fixed a problem where user defined calibration files were getting deleted on entering the PIM application a second time after a master reset.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
Application Package: V2.42
Release Date
: Quarterly Release Update August 2016
Information below may not apply to every model/option in Product list

*** BUG FIXES ***
-> Software - P25/P25p2
[SPH-1913] P25p2 - Fixed an issue that prevented S412E output signal synchronization with the received downlink signal.
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[SPH-2072] P25p2 - Tx output pattern now defaults to p252_ms_1031_0 to facilitate Base Station testing.
_________________________________________________________________________________
What will the customer see in this release?
Product
: S33xE, S36xE, S412E, MS202xB, MS203xB, MS202xC, MS203xC, MS2720T, MS822xB, MT8220T, MW82119B
Application Package: V2.40
Release Date
: Quarterly Release beginning July 2016
Information below may not apply to every model/option in Product list

*** NEW FEATURES ***
-> Software - VNA
[SPH-1744] Added support for interpolated markers in VNA mode. When marker values are set via the numeric keypad or via SCPI, interpolation will be used if the desired marker
x-axis value is not an actual measurement point. Markers will continue to snap to the nearest point if the twiddle knob or the arrow keys are used to set their location.
-> Software - dPMR
[SPH-1656] Added remote command support for dPMR.
-> Software - SPA and Sub-apps
[SPH-1914] New trace result types Max Hold and Total Max Hold added to EMF Measurements.
-> Software - OS/Base
[SPH-116] Added Quick Name Matrix support to Transmission Mode.
[SPH-1858] Added EasyTest repeat script capability.
-> Software - CPRI
[SPH-1804] Added Option 413 Ethernet, which is compatible with all options.
-> Software - P25/P25p2
[SPH-36] P25P2 - Added four new Control Channel summary displays - Active Control Channel Summary, Adjacent Site Summary, Band Plan Summary, Backup Control Channel
Summary.
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*** IMPROVEMENTS ***
-> Software - OS/Base
[SPH-1510] Fixed an issue where web server popups were showing up off screen on pages that can be scrolled.

*** BUG FIXES ***
-> Software - DMR2
[SPH-660] Fixed an issue with pan and zoom with indoor maps where data points would not zoom in sync with the map.
-> Software - NXDN
[SPH-660] Fixed an issue with pan and zoom with indoor maps where data points would not zoom in sync with the map.
-> Software - VNA
[SPH-502] Resolved an issue that prevented the instrument settings from getting preset after a measurement file was recalled.
-> Software - HiPM
[SPH-1606] Fixed a bug in High Accuracy Power Meter mode where max power for the MA24106A sensor could not be set up to +23 dBm.
-> Software - OS/Base
[SPH-104] Fixed as issue where Option 31 (GPS) was listed as an add-on option in MT8220T. It is standard in this model.
[SPH-107] Fixed an issue where instruments would respond to multiple IP addresses.
[SPH-1859] Fixed the issue where the instrument would hang at the last step when executing an easyTest script with the maximum number of steps(500) allowed.
-> Software - SPA and Sub-apps
[SPH-283] VBW set to correct bandwidth in Zero Span after presetting the instrument.
[SPH-284] Enabled ability to turn on Markers after sending Preset command over SCPI.
[SPH-289] Initial attenuation level values are restored after going in and out of Coverage Mapping.
[SPH-298] Fixed an issue where sweep time was not estimated correctly after preset
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[SPH-302] Preset SCPI command now resets Auto RBW from Off to On when C/I is turned On.
[SPH-303] RBW/VBW ratio returns to default value after AM/FM/PM mode switching.
[SPH-304] Navigation hard keys when map is not loaded works in Coverage Mapping.
[SPH-305] Fixed an issue where a mode switch, after Esc-On, from SPA into IA and then back into SPA, will cause the Save On Event button to vanish.
[SPH-307] Fixed an issue where IFBW state indicator in the status window displays incorrectly.
[SPH-325] Fixed an issue where recalling a measurement file with field strength units would not recall correctly.
-> Software - TETRA
[SPH-660] Fixed an issue with pan and zoom with indoor maps where data points would not zoom in sync with the map.
[SPH-1443] Fixed an issue where 'Received Pwr' of the summary display did not show power with in acceptable range.
[SPH-1513] TETRA - Fixed a bug where recalled measurements would not correctly populate values in the Summary Table
-> Software - NBFM
[SPH-660] Fixed an issue with pan and zoom with indoor maps where data points would not zoom in sync with the map.
-> Software - P25/P25p2
[SPH-660] Fixed an issue with pan and zoom with indoor maps where data points would not zoom in sync with the map.
[SPH-1665] Modified SCPI command to include new Summary display graphs in P25 P2 Analyzer measurement
[SPH-1690] Fixed Motorola Base Station Test in P25 Phase 2 app. Removed additional sampling that was added when when implementing FDMA Control Channel measurement.
Additional sampling was causing improper delay estimation for re-sync of signal pattern.
-> Software - PTC
[SPH-660] Fixed an issue with pan and zoom with indoor maps where data points would not zoom in sync with the map.
[SPH-1555] EVM and other summary measurements were adversely affected by PTC burst selection method when frequency offset between transmitter and receiver was more
than about 150Hz. The burst selection method was optimized to increase the frequency offset capability to at least +/- 340Hz. This should allow customers to measure the
standard of +/- 330Hz Wayside requirement.
Changed 'IQ Imbal' to 'IQ Offset' to better reflect all combined DC offsets (LO leakage, IQ DC Offset, etc...). Measurement now responds to changes in IQ DC Offset injection
________________________________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
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Application Package: V2.30
Release Date
: 6-27-2016
*** NEW FEATURES ***
General [2]
- Allow WEB server admin login to access all instrument control capabilities. QDF-79
- Added the ability to select and display favorites in the VNA Cable List.
Land Mobile Radio [1]
- Added support for TETRA Base Station Receiver Sensitivity testing.
Requires Signal Generator with 2 Gig of memory (LMR application self test will report memory size)
Requires Signal Generator FPGA V1.05 or higher (in application package)
Requires DSP FPGA V1.30 or higher (in application package)
Requires CPU FPGA V2.23 or higher (Contact Customer Service Center for update)
CPU FPGA, Sig-gen FPGA, Pattern RAM of 2 Gig and DSP FPGA versions are checked in order to provide visibility of TETRA BS Sensitivity test button.
LTE and TD-LTE Analyzer [1]
- Added Support for 4x4 MIMO LTE-FDD measurements.
High Accuracy Power Meter [1]
- Added support for MA243xxA USB power sensors.

*** ENHANCEMENTS ***
General [4]
- Substantial updates to Japanese language translation files for SPA and System applications.
- Substantial updates to Chinese language translation files for all applications.
- Updated Signal Standards files to include LTE Bands 29,30,31,32, and 66A to keep up with recent standards releases.
- Disclaimer notice on web server login page. QDF-81
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Land Mobile Radio [6]
- Made the rows in "Summary 2" window match "Summary" window to display same number of rows.
- Removed the gap between rows in "Summary 2" table.
- BER and MER/BER measurement no longer display "Summary" window in TETRA Base Station mode.
- Improved S412E spur performance at 937.3775 MHz.
- Added Sig-Gen flash size under Application Self-Test for LMR applications.
- TETRA application Load Patterns will allow loading of (binary) files.

*** BUG FIXES ***
General [3]
- Fixed an issue where the first time recalling a setup resulted in wrong marker info. #23367
- Fixed an issue with the first attempt to login to the web server after a timeout. QDF-80
- Fixed an issue where the file type warning message was not shown in the Select File Type dialog.
High Accuracy Power Meter [1]
- Fixed an issue with zeroing external USB high accuracy sensors.
LTE and TD-LTE Analyzer [2]
- Fixed an issue where the recalled channel power did not match the initially saved value #22962
- Fixed an issue where TD-LTE OTA Carrier Aggregation Measurement didn't detect MOD signal. #23779
Land Mobile Radio [2]
- Fixed an issue with "Cell ID" defaulting to 0 upon reselecting the Sync menu.
- Fixed an issue where DMR2 "Summary 2" Base Station ID was incorrect. It now shows '--'.
________________________________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
Application Package: V2.23
Release Date
: March 31, 2016
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*** NEW FEATURES ***
General [1]
- Added new administrative features to WEB server: access log and WEB banner settings.
Vector Network Analyzer [2]
- Added display Average Cable Loss on the top status menu when the measurement type is set to Cable Loss. #23448
- Added Page Up, Page Down, Top of List, Bottom of List soft keys to the Cable List. Added touch capability for cable list to allow user to
select the cable list using touch screen. #23487
Land Mobile Radio [3]
- Added support for option 572 dPMR Analyzer Coverage & option 573 dPMR Analyzer Measurement (RF) application modes to S412E LMR Master. #3311
- Added support to analyze bursted signals in PTC analyzer.
- Added TETRA Mobile Station mode (DMO) measurement

*** ENHANCEMENTS ***
General [2]
- easyTest will now replace existing measurements with the same name when performing an automatic file save operation associated with Sky Bridge
advanced scripts. Refer to Sky Bridge product release notes for individual product/option support.
- Updated the CableList.txt file to add 9 additional cables in response to customer request.
Vector Network Analyzer [1]
- Update the default scale for Insertion Loss, Return Loss, and DTF Return Loss for Field mode. Top is now default to 0.0dB and Bottom to
-100.00dB on models MS2024B, MS2025B, MS2034B, MS2035B and S412E

*** BUG FIXES ***
General [1]
- Fixed an issue where the IP address using DHCP was not updating even though there was an Ethernet cable connected in the E series instruments.
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This problem was seen only if booting up without the Ethernet cable connected. #23045
Vector Network Analyzer [1]
- Fixed an issue in Field mode where changing measurement type also changed the scale of other measurement types. #23370
Land Mobile Radio [14]
- *** DMR2 USERS ARE REQUIRED TO DOWNLOAD NEW SIGNAL GENERATOR PATTERNS FROM ANRITSU WEBSITE ***
- Fixed an issue in P25p2 where Descrambling not properly interpreting SACCH during Bit Capture
- S412E P25p2 now populates all Tx Patterns, regardless of Mod Type selection #23723
- Fixed an issue where P25p2 Control Channel Decode was not working properly #22354
- Fixed an issue where P25p2 menu navigation causes a system hang in control channel or bit capture measurements #22411
- Fixed an issue where P25p2 BER in 'Voice' Rx pattern seems not working #23380
- Fixed DMR2 Bit Capture Hang #23773
- Fixed DMR2 Bit Capture only top half of Display works #22919
- S412E DMR2 Tx time slot button removed, Rx TimeSlot button changed as appropriate #21661
- S412E DMR2 now populates all Tx Patterns, regardless of Rx Mod Type selection #23723:
- Fixed a glitch in DMR2 that affected the Tx output of dmr2_ms_1031 pattern
- Mod Type button in DMR2 changed to read "Rx Mod Type"
- Color Code selection added in DMR2 for pattern "dmr2_bs_1031"
- Log report for “Bit capture” in DMR2 will no longer capture “GPS not locked” message in between data sets
________________________________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
Application Package: V1.14
Release Date
: November 20, 2015
*** NEW FEATURES ***
General [1]
- Added a Web Server function for Ethernet-enabled instruments to allow easy remote control from a HTML 5 WEB browser.
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Land Mobile Radio [2]
- Added DMR2 support to decode embedded signaling and return call types during transmission.
- Added the Load Patterns functionality for each LMR application, available in the Application options menu. #2814

*** MISCELLANEOUS ***
General [1]
- Adjusted LCD Horizontal and Vertical timing to work with display manufacturer revision changes.
Updated SPL/IPL to V3.60 and ATABoot revision to V3.71 for improved the handling of battery charge termination while unit is in the powered
down state.
SPL/IPL and ATABoot are only available for update at Factory or Customer Service Centers.

*** ENHANCEMENTS ***
General [2]
- Added a warning that appears when downloading multiple files via a WEB browser now indicates that the process may make the instrument
unresponsive until the download is completed. If there is an error during the process, another message will appear to suggest a smaller
download. #22945
- Added additional monitoring of Battery SMBus to improve the handling of battery charge termination while unit is in operation. #23219.
Spectrum Analyzer and Sub-modes [1]
- Added Pan & Zoom functionality for .azm maps inside Coverage mapping measurements for SPA mode. #3217
Land Mobile Radio [3]
- Changed one of the default graphs for digital LMR modes DMR2, P25, P25p2, NXDN and PTC from Histogram to Eye diagram. #3172
- Changed the DMR2 Summary screen to show MS ID, Target ID, Talk Group ID, FID, Call Type and Base Station ID.
- Updated DMR2 SCPI commands :FETCh:SIGAnalyzer?, :MEASure:SIGAnalyzer?, and :READ:SIGAnalyzer? (See the Programming Manual for details). #22483

*** BUG FIXES ***
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General [2]
- Fixed an issue in WEBserver where SPL/IPL versions did not show. #23041
- Fixed an issue that could cause the Quick Name or the Quick Name Matrix button configuration to become undefined after a setup was saved via a
remote command or PC tool and recalled at a later time. #22810
Spectrum Analyzer and Sub-modes [4]
- Fixed an issue in IA RSSI mode where color of the trace changed erroneously from yellow to red while recalling a measurement. #23007
- Fixed an issue in SPA mode that prevented changing reference level using the rotary knob or arrow keys on the device. #22630
- Fixed an issue in SPA mode where changing the sweep time in Zero Span using the rotary knob or arrow keys would cause the value to fluctuate
before settling to the set value. #22803
- Fixed an issue where recalling a measurement caused the unit to go to the GATED SWEEP menu.
Vector Network Analyzer [2]
- Fixed an issue in mwVNA measurements where the limit line amplitude showed incorrect values due to rounding errors. #22834
- Fixed an issue where the markers in a recalled measurement did not display the marker values of the recalled measurement. #22204, 3338
Land Mobile Radio [7]
- Fixed an issue in DMR2 Summary mode where the data for FLCO and CSBKO appeared in the opposite position.
- Fixed an issue in DMR2 Summary mode where the data for Talk Group ID and Target ID appeared in the opposite position.
- Fixed an issue where mode switching from a DMR2 Summary display to PTC Mode would result in the DMR2 Summary screen showing up in PTC mode.
- Fixed an issue where PTC patterns were not visible when a unit upgraded from V1.11 to V1.12 or V1.12 to V1.13 #23236
- Fixed an issue where recalling a setup file via SCPI command put the unit in hold mode. #23377
- Fixed an issue where the Control Channel measurement button was showing up in DMR2 mode.
- Fixed an issue where the DMR2 summary information displayed CBSK instead of CSBK.
________________________________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
Application Package: V1.13
Release Date
: Aug 28, 2015
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*** NEW FEATURES ***
Spectrum Analyzer and Sub-modes [1]
- Enabled editing center frequency when in measurement setup menu of the coverage mapping mode. #21664
High Accuracy Power Meter [1]
- Added support for the MA24208A and MA24218A High Accuracy power sensors.

*** ENHANCEMENTS ***
General [4]
- Added the ability to lock an instrument from Telnet and FTP connections.
After setting the remote password and rebooting the unit, the unit will no longer allow Telnet and FTP connections.
To remove the lock, either do a factory reset or remove the remote password by setting it to blank. #22432
- Changed certain icons used in Night Vision mode for better visibility. #22831
- Made error message more meaningful when saving files with target memory nearly full. #21966
- WEB browser file download attempts are no longer possible with iOS devices. #22499
Vector Network Analyzer [1]
- Fixed an issue in mwVNA where Markers were not drawn after recalling measurement from file. #22205
Land Mobile Radio [2]
- Fixed an issue where SCPI command to change graph types in Tetra mode accepted invalid parameter options. #22276
- Fixed an issue where the NBFM data exported as CSV was inconsistent with the data shown on device UI. #22132

*** BUG FIXES ***
General [11]
- Changed the Spanish Language translation of ON/OFF to fit within the allowable space of the Marker Table. #22315
- Fixed an issue in easyTest module where a script with auto advance step would run until end when a dialog window is open on screen. #22554
Copyright© ANRITSU. All rights reserved.

Services & Support
1-800-267-4878
- Fixed an issue in the WEB UI of the device where the 'Menu' button would ocasionally not be displayed, when using Internet Explorer version
10/11. #22535
- Fixed an issue in WEB interface where the Remote Control screen did not show the instrument menu button when accessed through Safari browser.
#22158
- Fixed an issue in WEB UI of device where scale on the graph showed incorrect units under certain conditions. #22659
- Fixed an issue in WEB UI where some elements on the screen were not displayed properly in the browser, in SPA mode. #22659
- Fixed an issue in WEB UI where trace capture/save/download would cause an error when device is in ISDB-T SFN mode. #21790
- Fixed an issue where dragging an open dialog box would leave tracers on the screen. #21961
- Fixed an issue where the File type selection in Save dialog was very slow when using the twiddle knob. #22559
- Fixed an issue where the login button would not work on WEB server UI when accessing the device remotely with Safari browser. #22155
- Fixed an issue with file save error message shown on WEB server UI. Providing more relevant information as to the cause of the error. #21444
Spectrum Analyzer and Sub-modes [21]
- Fixed an issue in SPA mode where channel power used to show 0 dBm for smaller span values. #22772
- Fixed an issue in SPA mode where Emission Mask used to report "Fail" on segments that are actually a "Pass". #21687
- Fixed an issue in SPA mode where the marker value shown above graph area varied from the value shown inside the graph. #22083
- Fixed an issue in SPA mode, where counter marker showed marker in wrong location when switching frequency. #22400
- Fixed an issue in SPA module where the number of points for the limit envelope was not updated properly when limit envelope shape was changed.
#22821
- Fixed an issue in SPA module, where setting detection to Quasi Peak causes RBW to be restricted to 200 Hz. #22918
- Fixed an issue in Spectrogram mode where invalid data was shown on screen when the view setting for the trace was set to 'blank'. #22819
- Fixed an issue where Emission Mask would fail at times, even though the measurements were well below the limit lines. #21687
- Fixed an issue where more than 255 antenna factor points were not properly accepted by the device when reading an antenna.txt file. #21854
- Fixed an issue where RBW could be set to an invalid value in zero span under SPA mode. #21788
- Fixed an issue where recalling spectrogram measurement file causes unit reboot. #21952
- Fixed an issue where sweep time was not updated properly when auto sweep time was enabled in SPA mode. #22210
- Fixed an issue where the attenuation level was set incorrectly upon recalling a measurement in IA mode. #21981
- Fixed an issue where the SCPI command returns values with incorrect number of decimal point precision in SPA mode. #11751
- Fixed an issue where trace shows erroneous data when sweep mode changes while a sweep is in progress. #21868
- Fixed an issue with selecting a frequency within Mapping mode, the frequency pop-up obscures part of the GPS not locked warning.
GPS message has been moved to the bottom of the map area to prevent the overlap. #22240, #3045
- Fixed an issue with the "Distortion/Total Vrms" value returned by the SCPI data query did not match the value displayed in the table. #21597
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- Fixed an issue with the 'Back' button in the detection menu for SPA mode, to properly return to previous menu.
- Fixed an issue with the Limit Envelope Offset when using linear units of measure. #21558
- Fixed issue where measurement value "Distortion/Total Vrms" was not updated properly in GUI when in single sweep mode. #21597
- Fixed the issue in Channel Scanner mode where power readings and graph were updated in frequency scanner mode, for invalid frequencies. #21603
Vector Network Analyzer [2]
- Fixed an issue where preset operation did not work when calibration procedure had warnings. #21998
- Fixed problem with Auto gain ranging S21 measurements inconsistency. #22897
Land Mobile Radio [2]
- Fixed an issue where Linear Constellation was erroneously set as default graph type in TETRA mode after a Master Reset/Preset operation. #22792
- Fixed an issue where the control channel measurement button was showing up in DMR2 mode.
________________________________________________________________________________________________________
What will the customer see in this release?
Product
: S412E
Application Package: V1.12
Release Date
: April 10, 2015
*** NEW FEATURES ***
General [4]
- Added an error message pop up during Code Loading to notify the user in the case the USB stick does not have enough space to store all of the
user files from the instrument. #20524
- Enabling the Save on Event button in File menu for all LMR apps.
- File sort method and sort order will now be persistent through window closes.
- Updated the Support File, Antenna.txt to include Anritsu Antenna 2000-1715-R
Spectrum Analyzer and Sub-modes [8]
- Added a new SCPI command, "CALCulate:MARKer#:MAXimum:NEXT" to move the marker to the highest peak anywhere in the trace which is lower than
the current marker.
If the given marker is not on, the command turns it on and sets it to the second highest peak in the trace.
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The command uses the existing peak threshold values to determine what is and is not a peak.
- Added a special key combination (Shft+9+5+3) which loads a frequency calibration button in the System Menu to allow Customer Field Calibration
of the 10MHz Reference for SPA only measurements. See the Maintenance Manual for details on use. #20761
- Added commands to check for end of sweep in SPA and LTE modes.
1) In LTE/TD-LTE mode :[SENSe:]LTE:STATus?
Returns 1 when sweep is complete. Returns 0 when sweep is in progress.
2) In SPA mode
:[SENSe:]SWEep:STATus?
Returns 1 when sweep is complete. Returns 0 when sweep is in progress.
See Programming Manual for details.
- Added Span Setting to ACPR coverage mapping mode. #20923
- Added warning message when turning on markers 2-6 with marker 1 reference ON.
With Marker 1 reference turned ON, turning on other markers with Delta markers OFF now turns On the Delta Marker with warning message. #21472
- First Release of EMF measurements. (option 444)
- Save Measurement and JPG feature added for AM/FM/PM mode. #21670
- User can now select FM scale % values with a minimum of 0.01%. #21502
LTE Analyzer [2]
- Added commands to check for end of sweep in SPA and LTE modes.
1) In LTE mode
:[SENSe:]LTE:STATus?
Returns 1 when sweep is complete. Returns 0 when sweep is in progress.
2) In SPA mode :[SENSe:]SWEep:STATus?
Returns 1 when sweep is complete. Returns 0 when sweep is in progress.
See Programming Manual for details.
- First Release of EMF measurements. (option 444)
Land Mobile Radio [1]
- Added summary graph type to DMR2 mode.
Added Power profile graph type to DMR2 mode.
Removed slot buttons from DMR2 setup menu in mobile station mode.
Added Save on squelch functionality for all LMR modes.
Squelch limit is now -130dBm.
Added NXDN 5% BER pattern.
Auto Range is set to off after preset on all LMR modes.
Histogram and Linear constellation graphs removed from TETRA mode.
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*** ENHANCEMENTS ***
General [5]
- Added more information to an error message that pops up when attempting to run an easyTest script in the wrong application mode. #20775
- Free space on the storage device will be checked before JPGs can be saved. #21369
- The same file type used when SAVING a measurement, is initially selected when opening the RECALL measurement dialog.
- Updated Support files.
Updated the Antenna.txt file by adding 3 antennas.
Updated the CableList.txt file by adding 13 cables.
Updated the Signal Standards File by replacing 43 Standards that had been previously removed. (CDMA, Fixed WiMAX, TD-LTE, and a
number of the 700MHz bands)
- Updated the Support File, CableList.txt, by adding support for an additional manufacturer of RG58C-U Cable with a propagation velocity
of 0.656
Spectrum Analyzer and Sub-modes [7]
- Changed the lower limit of the CS Frequency BW from 0 to 1 Hz. #21663
- GUI updates are now consistent after Spurious Emission segment changes via SCPI. #18981
- Improved Counter Marker Stability. #20559
- Limited minimum sweep time entry to 7 us. #20406
- Made improvements in Counter Marker accuracy. #20982
- Main Channel power no longer shows invalid values when Span is less than Main Channel BW. #20922
- When recalling saved setup, invalid channels/frequencies are shown as "--" and readings are masked out corresponding to the invalid channels.
#21603
Vector Network Analyzer [2]
- Added spur avoidance to remove known spurs for VNA Modes.
- Increased user cal kit maximum capacitance and inductance value from 2000 to 100,000. #20910
LTE Analyzer [1]
- Added functionality to decode signals with 2ms delay between them in LTE modes.
Land Mobile Radio [2]
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- Increased the minimum squelch setting for LMR Master to -130 dBm.
- Turning the the Rx Auto Range to off after a preset so the preamp does not turn on.

*** BUG FIXES ***
General [12]
- Files or directories with leading spaces in their names cannot be saved. #21560
- Fixed an issue where "fW" was displayed when "fA" was expected. #20911
- Fixed an issue where a '(null)' was displayed on unit buttons. #21038
- Fixed an issue where a Save/Recall message would partially cover the parameter status area. #20786
- Fixed an issue where icons in Save/Recall window were not being updated to match the current color scheme of the device. #20996
- Fixed an issue where the Save On Event button would show up in IA Mapping measurement mode. #21471
- Fixed an issue with an overflowing USB SCPI command queue by increasing the buffer size from 50 to 500.
This solves a problem where the queue was overflowing from SCPI commands. #21312
- Fixed an issue with changing the instrument device name to close the dialog box cleanly. #21135
- Fixed an issue with 'Save Measurement As' to properly handle multiple '_' in the filename. #20540
- Fixed an issue with the date/time window focus, shifting behavior after an error encountered while attempting to set a leap year date in a non
leap year. #21366
- Fixed an issue with the Save/Recall dialog screen size. Enlarged the screen to allow entire warning messages to fit. #20113
- Updated Portuguese translation tables to eliminate 3 erroneous Russian translations from WiMAX mode.
Spectrum Analyzer and Sub-modes [17]
- Added a Gate delay maximum value, and set it to 100 ms. #21441
- Fixed a problem where manually setting a sweep time with a narrow span on single sweep mode caused a very inaccurate actual sweep time to be
reported. #20558
- Fixed an error in the header information generated in Spectral Emissions Spurious Emission files. #21207
- Fixed an issue in zero span, where Marker units are sometimes in Hz, after changing from log amplitude units to linear amplitude units. #20626
- Fixed an issue where ADC Over Range Error message did not appear on the screen when a marker was not located within the ADC Over Range area of
the trace. #20493
- Fixed an issue where not all coverage mapping measurement mode settings were not set properly to default values while performing preset. #20920
- Fixed an issue where the BW could be set to 0 in Channel Scanner Custom Scan list.
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This is now limited to 1 Hz. #21960
- Fixed an issue where the Save On Event button would show up in IA Mapping measurement mode. #21471
- Fixed an issue where the spectrogram trace count did not reset with Sweep Interval if the Trace mode was set to average. #20609
- Fixed an issue where there were differences between the recalled measurement and JPEG files color and location of vertical reference lines.
#20341
- Fixed an issue with recalled Spectrogram colors corrected to match the colors during measurement. #20584
- Fixed an issue with some error messages that erroneously referred to "Time Span" instead of "Recording Time" #21062
- Fixed an issue with Sweep Once when invoked via SCPI command. #18978
- Fixed an issue with the header units for Attenuation in Spurious Emission file. #21568
- Fixed an issue with the Input Attenuation setting after loading a saved setup file. #21482
- Fixed single sweep not sweeping when manually triggered with auto sweep time turned on. #20981
- Fixed the Frequency units in Spurious Emissions measurement. #21208
Vector Network Analyzer [4]
- Fixed a problem where the center and span were being restored to the default values as opposed to the values before cal.
This problem is encountered when redoing a cal, prior to which the center and span had been updated during a full range cal. #20948
- Fixed an issue where Scale and Frequency were not redrawn after using shortcut key to switch to VNA mode from SPA. #21023
- Fixed an issue with the Group Delay scale for higher units of measure. #20908,
- Fixed an issue with Time Domain, to update trace when waveguide cutoff was changed. #20544
High Accuracy Power Meter [2]
- Fixed an issue with the Save Measurement button in High Accuracy Power Meter. Now it correctly selects a measurement file type instead of a
setup file type. #21088
- Hi Accuracy Power Meter summary window now correctly clears with preset command. #21352
LTE Analyzer [1]
- Fixed an issue with SCPI commands for carrier aggregation.
The wrong number of dashes("--") were being returned for the data string when an invalid signal was detected.
Mobile WiMAX Signal Analyzer [1]
- Fixed an issue where Mobile WiMAX files were incorrectly recalled using remote commands. #21065
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______________________________________________________________________________________________________________________________________
What will you see in this release?
Product
: S412E
Application Package: V1.11
Release Date
: 10/17/2014
*** NEW FEATURES ***
General [3]
- Added custom Quick Name Matrix information in setup files for VNA applications.
- Added GPS location in radians to saved measurement file headers.
- Added the firmware package version number to saved measurement files.
Land Mobile Radio Modes [1]
- Added Audio SINAD measurement to the Coverage Mapping mode in the NBFM application.

*** ENHANCEMENTS ***
General [11]
- Added a timer that automatically dims the display of the instrument when it is operating under battery power to save power. "Auto-Dim" feature
can be enabled in System Options -> Display -> Brightness menu. #2521
- Added a warning message to the SAVE FILE dialog to indicate excessive files saved in a single directory, which may slow down file access
performance.
- Added ellipses for long names when using quick name matrix buttons. #19341
- Added line-wrapping for option numbers in the System Status dialog. #19979
- Added Portuguese language support.
- Allowing setup file shortcuts under the Menu Button to use spaces in the name. #19355
- Displaying >1 hr for sweep time estimates over 1 hour instead of showing ~1.2 hours.
- Improved GPS frequency accuracy during temperature changes. #19096
- Improved handling of Recall KML Points & Map when the map is not available. #18638
- Improved Russian language translation. #19993
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- Marker display now shows smaller values properly without error in placement of decimal point.
Spectrum Analyzer and Related Modes [12]
- Added 0|1 as valid parameters to the SCPI Command ":CALCulate:MARKer:TABLe:STATe" command for consistency with Programming Manual. #20089
- Added support for longer antenna names. #18714
- Added the ability to continue capturing bearings with the MA2700A after switching from Interference Mapping to Interference Analyzer Spectrum
measurement.
- Changed minimum value for recalled center frequency to 0 Hz in Spectrum Analyzer application after power cycle. #20021
- Improved auto reference level adjustment for field strength mode as measurement units are changed. #18642
- Improved counter marker peak search operation. #19891
- Improved zero span narrow VBW performance in Interference Analyzer Spectrum mode. #19248
- Increased maximum value of RSSI time span to 7 days (60*60*24*7 = 604800 seconds).
- Preset will now default the upper envelope limit number of points to 20.
- Revised the EEPROM error message. #18651
- Saturation and ADC over-range error messages are cleared more quickly in zero span and IA signal strength modes.
- Selecting "All Measurements Off" now will turn coverage mapping off, so last span will be restored. #19502
mwVNA Analyzer [5]
- Increased Reference Plane Length minimum from -100m to -1000m and maximum from 100m to 1000m
- Increased Reference value minimum for Group Delay from 0 to -1ms.
- Updated ":VVM:FETCh:DATA?" SCPI command. See Programming Manual for details.
- Updated Phase Reference Line Max value from 0 to 10. Updated Phase Reference max from 180 to 225 and min from -180 to -225. #19333
- Updated Vector Volt Meter IFBW to be a tri-state button when in field mode. #19186
LTE Analyzer [3]
- EVM Max hold values (peak max and rms max) reset when either the BW, Frequency, Cyclic Prefix, EVM mode, or EVM max hold changes.
- Remove the inaccurate warning message from demod and over the air measurements.
- Removed erroneous "bch signal" field while in the constellation measurement view.
Land Mobile Radio Modes [1]
- Updated LMR Language Translation files.
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Operating System [4]
- Added support for newer NAND file storage hardware.
- Improved error handling for WiFi TCP data transfer functions.
- Improved timing of motherboard self test to prevent false reports of -5.8 Volt failures.
- Saving instrument setup on power down has been sped up to prevent loss of setup information.

*** BUG FIXES ***
General [10]
- Fixed an intermittent hang up when recalling setups from a touchscreen menu shortcut. #19066
- Fixed an issue related to defaults on Quick Name features causing unit lockup. #20441
- Fixed an issue that displayed "Successfully Saved File to USB1" when the save operation failed due to the disk being full.
- Fixed an issue where ":MMEMory:DIRectory?" command was returning incorrect filenames and extensions. #19358
- Fixed an issue where pressing the touchscreen enter key twice when saving a JPEG obscured the graph with the Save dialog. #19775
- Fixed an issue where the instrument would shut down after scrolling to the bottom of the System Status window using the touchscreen.
- Fixed an issue where the user could not use the left/right arrow keys to navigate the buttons in the "Confirm File Delete" dialog when the
instrument language was set to French. #19073
- Fixed an issue with incorrect values being displayed for marker frequency, for values less than 1 Hz (positive and negative values).
- Fixed an issue with the touchscreen user interface for remote user passwords. #18640.
- Fixed the French translation for "Save Measurement As". #19074
Spectrum Analyzer and Related Modes [17]
- Fixed a display issue with external trigger level line appearing when External Trigger selected. #18623
- Fixed a problem with instruments not remembering field strength measurement setup state following power cycle.
- Fixed an intermittent issue with Presetting the instrument in Zero Span Mode. #20439
- Fixed an issue in IA mode where the limit line would not get reset properly following a preset. #19998
- Fixed an issue in Spectrum Analyzer mode that did not show a warning dialog when saving a measurement file with existing filename. #20011
- Fixed an issue involving SCPI command to change Trigger Mode to Free Run.
- Fixed an issue that did not list all files in the Recall dialog. #19989
- Fixed an issue to restore the Reference level correctly when Field Strength is turned On/Off with linear units (Volt, Watt and A).
- Fixed an issue when incrementing or decrementing sweep times with arrow keys or twiddle knob.
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- Fixed an issue where Frequency Reference = "GPS High Accuracy" was not always reported correctly. #19181
- Fixed an issue where the Spurious Emission menu could show up in the IA mode.
- Fixed an issue where under unique conditions, the counter marker could show incorrect frequency values.
- Fixed an issue with "preset" when field strength is enabled. #19595
- Fixed an issue with Recalling an AM/FM/PM measurement file with a marker on, now retains original marker position rather than snapping to
center screen. #20318
- Fixed marker units not getting updated immediately after switching units. #18516
- Fixed squelch amplitude bug in AM demodulation mode below 8 MHz. #18621
- Fixed the Channel Power Measurement table not getting drawn after recalling measurement file or using several related SCPI commands. #19518,
#18917
LTE Analyzer [6]
- Fixed an intermittent issue with the instrument freezing when changing parameters or changing measurements within LTE.
- Fixed an issue in Tx Test measurement, where a displayed Delta Value was shown, even when a single Tx Antenna was in use.
- Fixed an issue where the RSRP measurement in Channel Scanner was not stable. #20496
- Fixed an issue with recalling a file in LTE Pass/Fail mode, causing the unit to lock up with hour glass. #20473,16058
- Fixed an issue with the Back button in Power vs Resource Block menu in LTE and TD-LTE modes returning to the wrong menu. #20765
- Spectral Emission Mask status now shows "--" instead of "Fail" when measurement is not complete in LTE and TD-LTE modes
Land Mobile Radio Modes [3]
- Fix for NBFM application where SINAD measurement crashes when CTCSS frequency is changed by user. The fix pauses the sweep while the frequency
is changed and resumes when the change is completed.
- Fixed an issue where the BER would save 101% to the KML or MTD file when the data could not be synced in Coverage Mapping mode. It will now
show "--" instead.
- Fixed an issue with SCPI commands "DM.PATTern VOIC" and command "DM.PATTern?" to provide correct responses in all P25p2 modes. #20411

______________________________________________________________________________________________________________________________________
What will the Customer See in this release? S412E Application Package V1.10 02-19-2014

General Features
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---------------- Fixed an intermittent problem where an EEPROM error message was displayed.
- Fixed a problem turning on the LED indicator at initial power up. Requires IPL/SPL/ataBoot version 3.28 or later.
- Added a backspace button for entering numbers.
- Fixed a frequency display accuracy problem.
- Fixed a problem when aborting the touch screen calibration.
- Fixed a problem with editing and saving of instrument names.
- Fixed a problem where ":SENSe:FREQuency:STARt" SCPI command truncates the last digit when setting frequency beyond 4,294,967,295 Hz.
- Fixed a problem with pressing '1' when Signal Standards List is displayed.
- Fixed an issue with the help window not closing.
- Added a selection in file save menu to save measurement file with a JPG screen capture.
- Fixed a problem where a setup was saved as a .dat in some cases.
- Fixed a problem with displaying large Russian fonts.
- Addressed an issue with accessing the bottom of the "Select Save Location" pop-up window.
- Added more descriptive file save error messages.
- Restricted the ability to copy from a parent directory into a subdirectory.
- Fixed a cosmetic issue with the touchscreen menu display when changing applications.
- Fixed a defect related to inconsistency between the accuracy of limit point amplitude values displayed and those saved to a measurement file.
- Corrected storage/directory names displayed in the file save/copy dialog boxes.
- Added a special case for the battery selftest so that it doesn't indicate failure when the battery is not installed,
but it indicates that there was no response from the battery so that the user can decide if there is a failure or not.
- Fixed an issue where moving or resizing a popup window was a problem.
- Fixed an issue where GPS could not be turned ON or OFF correctly while a recalled Trace was in view,
resulting in the On/Off Status being out of sync with button state.
- Fixed an issue with setting the date to Feb 29 in a leap year.
- Corrected a rounding issue from tenths of Hz for frequencies.
- Button text changes in System Display Settings menu.
- Added an EEPROM snapshot feature for troubleshooting. A folder named "Anritsu_Snapshot" in the
internal memory can be deleted for security purposes.This feature does not apply to units with option 7.
- Added Atomic Clock option for frequency reference
- When Remote Access Password is set, it will now display *'s in its entry field
- Fixed a possible timing issue when switch mode repeatedly
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- Applied Night Vision mode at boot-up. IPL/SPL/ataBoot V3.50 or higher is required

Vector Network Analyzer Application
----------------------------------- Addressed an issue which was causing the Memory trace frequency axis to be incorrect if the number of points were changed after the display was set to Trace and Memory.
- Addressed an issue where the limit line showed up as a single point when the limit was turned on with the sweep in hold.
- Addressed an issue where the Marker step size was not getting correctly reduced after reducing the number of points in a sweep, causing the twiddle knob to appear less
responsive.
- Re-labeling of Source Power (Before High now Default, Before Max now High)
- Updated Cable List to V3.04
* Fixed/modified the following cables: RG-214, UCF114-50JA, AL5-50, LCF12-50J, and RG-174
* Added the following cables: UCF114-50JA-A0, AVA5-50FX, RG214-50JF, RG331/U + FXA12-50J, AVA6-50, EA5-50,
EA7-50, AL4RPV-50, HS2RP-50, LMR195, LMR300, RG-217, RG-218, RG-331, RG-333, SCF38-50J and SCF14-50J
* Also added a series of aluminum cables

High Accuracy Power Meter Application
------------------------------------- Fixed an overlapping test when using MA24105A sensor.
Spectrum Analyzer Application
----------------------------------- Added Out-of-band Spurious emissions measurement.
- Fixed an issue with Max Hold in Field Strength.
- Fixed a problem with Set Marker to Channel.
- Fixed a problem with turning on QP detection when VBW type is as Log.
- Fixed a problem when the Reference Level unit is set to Volts or Watts.
- Fixed a problem with the Counter Marker units in Field Strength.
- Fixed a Sweep Time problem when RBW is narrow.
- Fixed firmware crashing when touching the button on the upper right corner of display all traces window.
- Fixed an issue where the GPS reference frequency does not always lock.
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- Changed the Preamp warning message to reflect the Reference Level Offset.
- Fixed an issue where the wrong units were displayed while measuring channel power in units other than dBm.
- Fixed an issue with Limit Envelope not working correctly if the units were Volts or Watts.
- Fixed shape cal instruction available in service mode.
- Fixed an issue where KML(2D,3D) and Mapping Tab Delimited file types could not be selected or saved from File Save menu.
- Fixed an issue where certain parameters were converted to selected units during an increment/decrement operation resulting in a wrong display.
- The limit line will now stay visible regardless of which traces are visible or blanked.
- Fixed an issue where file recall during Save On Event crashes the unit. The operation is not permitted and a warning message has been added.
- Fixed an issue where Trace B was not visible by default after recalling a C/I measurement.
- C/I measurement "Min Sweep Time" button is now correctly labeled "Sweep Time".
- Fixed coupling of RBW and VBW in signal strength or RSSI with RBW and VBW in non-zero-span spectrum analyzer.
- Markers that would exceed the top of the graph area are now flipped below the trace in a downward orientation so they remain visible.
- Fixed an issue where TG Output Power twiddle/arrow key increment amounts were not correct.
- Fixed inconsistency in the precision of the limit value as displayed on the instrument and in LST.
- Updated Russian translation.
- Updated Chinese translation.
- Updated pre-amp, input attenuation, reference level interactions.
- Adjusted reference level maximum for Field Strength.
- Fixed a problem with IQ Waveform Capture when the USB memory is full.
- Increased resolution for Sweep Time annotation when in Zero Span
- Fixed a problem with power level displayed when there is a high level power input
- Fixed a problem with recalling a saved working Gated Sweep setup
- Added a safeguard to Prevent a user from starting coverage mapping data collection when GPS is not locked
- Fixed incorrect measurement with No FFT sweep mode, RBW 1 Hz, and VBW > 1 Hz
- Provided RBW delay compensation in zero-span
- Added a minor change for WinLMF operation:
- improves stability of power measurements in PM mode
- avoids GUI crash after cable calibration
- Fixed a timing issue causing successive updates to the same parameter to be received out of order in the GUI.
- Fixed an issue where the marker value wass not displayed in the upper left corner of the screen When switching
from spectrum view in IA mode with a marker displayed to SPA mode.
- Fixed an issue of unit frozen and lost data while doing spectrum monitoring.
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- Fixe a problem with the Gate-View display when there is no external trigger.
- Disabled Segment Setup in continuous sweep mode.

Interference Analyzer Application
----------------------------------- Added MA2700A support.
- Added .azm support for IA Mapping.
- .azm maps are zoomable and panable.
- .azm maps are created by using easyMap.
- Fixed a problem with Signal ID when the span is much wider than the bandwidth of the generated signal.
- Fixed a problem with Reset/Restart Measurement soft key in spectrogram not resetting the max hold accumulation.
- The messaging when in Single Sweep was not consistent with the functionality of the instrument, this has been fixed.
- Fixed a problem with adjusting Recording Time with the knob in Spectrogram mode
- Increased tone rate for Signal Strength
- Fixed an issue with Burst Detection where it stopped functioning with certain key sequence
- Sweep Interval will have effect only if selected trace is in Max or Min Hold.
- Spectrogram display is now for the selected trace.
- Spectrogram Status window changed.
- Added Spectrogram stitch feature for Master Software Tools.
- Added maximum and minimum values for the Reference Level.
- Disabled the Units menu while in Spectrogram mode.
Channel Scanner Application
----------------------------------- Added boundaries for the Reference Level.
- Adjusted the frequency range for some models.
- Fixed ddc failure and error when choosing certain signal standard in channel scanner.
- Fixed an issue with Frequency Scanner allowing set channels to exceed the instrument's sweep range.
- Fixed an issue where the instrument could hang if different rows were selected in the Channel Scanner Custom List Edit dialog.
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AM-FM-PM Analyzer
----------------------------------- Fixed a problem with the sound output in Audio Demod.
- Fixed a problem with displaying large marker table
Vector Volt Meter
----------------------------------- During preset, Source Power and IFBW will be set to default value.
- Addressed an issue in which VVM phase results became erratic when DUT phase was exactly equal to 180 degrees
LTE Analyzer
----------------------------------- Added Extended CP support.
- Fixed a lockup when switching out of TX Time alignment.
- Fixed a lockup after recalling measurement.
- Fixed the backspace for marker edit.
- Fixed an issue where the reference level changes when external reference switched.
- Fixed an issue where the instrument hung after escaping from a recalled measurement.
- Added LTE and TD-LTE scanner speed-up.
- Fixed an issue while recalling an auto saved measurement file.
- Fixed a problem with clearing a measurement file after a recall.
- Fixed an issue with incorrect values when recalling measurement files.
- Fixed an issue where lock failures were falsely reported during switching reference.
- Fixed an issue where in certain instances one could not make shortcuts for touch screen softkeys.
- Fixed several issues with the SCPI commands.
- Fixed a bug in OTA scanner where incorrect Dominance was displayed when multiple signals were reported.
- Added improvement to auto-ranging algorithm.
- Addressed a cosmetic issue in the OTA Scanner menu.
- Fixed a problem while Recalling a Tx Test Measurement file
- Fixed a problem where an extra sweep was triggered in Single Sweep mode after saving a Power vs RB measurement
- Fixed a problem with bad Power vs Resource measurement data in save/recall
- Fixed a problem with save/recall in channel Spectrum
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- Fixed a problem where the Channel # was displayed incorrectly when switching from SPA
- Fixed a problem with mode switch when OTA > Auto Save is in progress
CW Signal Generator
------------------- Fixed a problem where "Center Freq" text covered the meter numbers.
- Fixed an issue where Sig Gen app allowed user to adjust in 0.1 dB steps on Rev 1 hardware.
Fixed WiMAX Signal Analyzer
----------------------------------- Fixed a difference in scale/div and value displayed in graph.
- Fixed a SCPI command that reported the wrong span.
Mobile WiMAX Signal Analyzer
----------------------------------- Fixed a difference in scale/div and value displayed in graph.
- Fixed a SCPI command that reported the wrong span.
P25 Phase 2 Analyzer
----------------------------------- Fixed a bug that allows users to start coverage mapping without GPS lock
- Fixes an issue where portions of the save/recall dialog box would be saved along with the JPEG in coverage mapping
P25 Analyzer
----------------------------------- Fixed a bug that allows users to start coverage mapping without GPS lock
- Fixes an issue where portions of the save/recall dialog box would be saved along with the JPEG in coverage mapping
NXDN Analyzer
----------------------------------- Fixed a bug that allows users to start coverage mapping without GPS lock
- Fixes an issue where portions of the save/recall dialog box would be saved along with the JPEG in coverage mapping
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DMR 2 Analyzer
----------------------------------- Fixed a bug that allows users to start coverage mapping without GPS lock
- Fixes an issue where portions of the save/recall dialog box would be saved along with the JPEG in coverage mapping
PTC Analyzer
----------------------------------- Removed 4FSK modulation type
- Removed symbol rates of 6k, 12k, and 18k (corresponding patterns removed as well).
- Changed the prefix ptc_dqpsk in pattern names to o153_cont.
- Added PN9 patterns
* pn9_normal_1
* pn9_normal_2
* pn9_normal_3
* pn9_normal_4
* pn9_normal_seq
- Changed the mod fid measurement result to EVM
- Fixes an issue that prevents the user from starting coverage mapping collection unless there is a GPS lock
- Fixes an issue where portions of the save/recall dialog box would be saved along with the JPEG in coverage mapping
- Added support for burst signals
- Added support for new PTC patterns

NBFM Analyzer
----------------------------------- Fixes an issue with glitches appearing for various combinations of 1kHz + CTCSS output signals.
- Fixes an issue with various graphics on the Quieting measurements not being drawn onto the screen after a save/recall
- Fixes an issue that prevents the user from starting coverage mapping collection unless there is a GPS lock
- Fixes an issue where portions of the save/recall dialog box would be saved along with the JPEG in coverage mapping
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TETRA Analyzer
----------------------------------- Initial Release

===========================================================================================
What will the Customer See in this release? S412E Application Package V1.09 4-8-2013
Internal Release: support for change in anti-backlash setting in LO2.
=========================================================================================
What will the Customer See in this release? S412E Application Package V1.08 12-7-2012
Internal Release: Fix for a NAND flash problem.
=========================================================================================
What will the Customer See in this release? S412E Application Package V1.07 11-12-2012
Internal Release: Support for NAND flash.
=========================================================================================
What will the Customer See in this release? S412E Application Package V1.06 10-12-2012

General Features
---------------- Changed File deletion user interface to prevent user from accidentally deleting all files.
- Added more granularity to the brightness adjustment
- Added 'Display Blank', which turns off the whole display
- Added 'invert Black and White'
- Japanese language translation updated
- In Language Selector, 'Custom 1' is now 'Russian', 'Custom 2' is now 'Custom'
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- When combined with a DSP FPGA V1.03 upgrade, the resolution for Tx level has been increased from 0.5dB to 0.1dB
Vector Network Analyzer Application
----------------------------------- Fixed an issue where amplitude menu shows incorrect buttons after switching from field mode to VNA mode.
- Fixed an issue where the first point of a trace would randomly spike.
- Fixed an issue where the cable list could not be updated through MST or LST.
- Fixed an issue where the CALCulate:MARKer#:X? SCPI command was returning 0 Hz for markers on all traces.
- Changed default IF BW from 10 kHz to 1 kHz.
- Improved DTF loss per foot calculation for frequencies below 1000 MHz.
- Added an automatic IF Gain Cal during first bootup after firmware update. Please note that reverting back to older firmware will require the unit to be sent into a service center
to re-run the IF Gain Cal.
High Accuracy Power Meter Application
------------------------------------- No Changes.
Spectrum Analyzer Application
----------------------------------- Fixed a bug where RSSI was not reflecting Ref Level Offset correctly in coverage mapping mode.
- Fixed a bug where a Counter marker's location on the screen would not match its actual frequency.
- Sweep Time is now displayed with an initial 'estimate' for the first sweep and updated to measured values in subsequent sweeps.
- Added support for new units - dBW, A and dBA and Watt/cm2 in Field Strength mode.
- Added new measurement units for Field Strength
- Added new Antenna EMI display option
- Fixed a bug with Option 89 (IF Output) where the button to turn on the output wouldn't work correctly
- Fixed a bug where level accuracy was affected by ~2 dB with the 3 MHz RBW filter in certain spans
- Fixed several units and marker related bugs
- Fixed a bug that would cause Bias Tee output voltage to increase after performing a preset. Bias Tee will now be turned off after performing a Preset
- Fixed a problem when moving markers using touch screen in zero span
Interference Analyzer Application
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----------------------------------- Fixed a bug that would cause Bias Tee output voltage to increase after performing a preset. Bias Tee will now be turned off after performing a Preset
Channel Scanner Application
----------------------------------- Fixed a bug that would cause Bias Tee output voltage to increase after performing a preset. Bias Tee will now be turned off after performing a Preset
- Fixed a DDC error when selected signal standards have span less than ~40 MHz.
AM-FM-PM Analyzer
----------------------------------- Fixed an audio output problem when turning on Audio demod
- Fixed File Save menu to include KML (2D/3D) and Tab delimited
- Fixed a problem with coverage mapping when switching applications
- Fixed a problem displaying ADC over range & Saturation messages in the Summary window.
Vector Volt Meter
----------------------------------- No Changes.
P25 Phase 2 Analyzer
----------------------------------- Initial release.
- Note: For units shipped prior to this FW release, DSP FPGA V1.03 and LMR Patterns V1.03 upgrade is needed for the customer to obtain fulll P25 Phase 2 functionality. Please
contact Customer Service for quotaion on either rework or replacement of the Signal Generator subassembly.
P25 Analyzer
----------------------------------- Added back the older graph-based coverage mapping GUI as an option. The user now has a choice between graph-based and with map-based coverage mapping GUIs.
NXDN Analyzer
----------------------------------- Modified GUI to reflect NXDN standard for RAN being stated in decimal, not hexadecimal
Copyright© ANRITSU. All rights reserved.

Services & Support
1-800-267-4878
LTE Analyzer
----------------------------------- Added Tx Time Alignment measurement
- Added support for EVM measurements on each control channel
- Added support for PHICH and PDCCH control channel measurements
- Added overall EVM and EVM per modulation type in the Power vs RB view - this allows EVM measurements over the full frame
- Added OSTP measurement to the Power vs RB view
- Added ability to manually select masks for Spectral Emission mask test
- Added support for in-instrument Mapping
- Added additional SCPI commands
- Fixed several remote command related bugs
- Added Scanner Improvements for
o
Better differentiation of 2 signals with the same sector ID
o
Improved cell ID stability
Fixed WiMAX Signal Analyzer
----------------------------------- No Changes.
Mobile WiMAX Signal Analyzer
----------------------------------- No Changes.
DMR 2 Analyzer
----------------------------------- Modified GUI to reflect ETSI DMR standard for Color Code being stated in decimal,
not hexadecimal.
PTC Analyzer
----------------------------------- No Changes.
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NBFM Analyzer
----------------------------------- Added an Averaging button for SINAD and Quieting measurements
- Added numeric annotations for SINADand Quieting measurements
- Sweep speed improved by about 300-400ms
- Added support for generating CTCSS/DCS while in SINAD mode
- Added support for choosing Peak/Average/RMS deviation
- Added support for turning C-message filtering on/off
CW Signal Generator
------------------- Fixed a problem in recalling a setup file
===========================================================================================
What will the Customer See in this release? S412E Application Package V1.04 11-17-2011

General Features
---------------- Added a new feature which automatically pops up a firmware update window when a USB stick
containing the firmware is attached to the instrument.
Vector Network Analyzer Application
----------------------------------- Added 1-Port Reponse and 2-Port Response calibrations in field mode.
High Accuracy Power Meter Application
------------------------------------- Added support for the new power sensor model MA24240A, and MA24105A.
Spectrum Analyzer Application
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----------------------------------- Fixed the problem of which marker jumps onto trace A when user presses button to search
next peak to the left/right.
- Stopped displaying antenna factor in field strength measurement if the spectrum measurement
is outside of the valid antenna's frequencies.
- Disallow recalling of a setup if the instrument is in measurement recall mode.
Interference Analyzer Application
----------------------------------- Fixed the problem of which the spectrum sweep doesn't reset after it has been recorded into
the spectrogram trace under some circumstances.
Channel Scanner Application
----------------------------------- Fixed the problem of which the signal standard list window was dismissed prematurely when
user has selected an invalid signal standard such as "NONE."
AM-FM-PM Analyzer
----------------------------------- No changes
Vector Volt Meter
----------------------------------- No Changes.
P25 Analyzer
----------------------------------- Replaced graph based coverage mapping with map based coverage mapping.
NXDN Analyzer
----------------------------------- Replaced graph based coverage mapping with map based coverage mapping.
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- Added the following Tx patterns:
1. nxdn_1031_dts_9600
2. nxdn_facch3_dts_9600
3. nxdn_1031_dts_4800
4. nxdn_facch3_dts_4800
Please note: Unit must be returned to service center to load and verify the new NXDN patterns.
LTE Analyzer
----------------------------------- Added OSTP, Frame EVM in Power vs. RB.
- Added EVM for each modulation type in mod summary window.
- Added indicator for EVM Auto status.
- Added indicator for which antenna was detected.
- Added EVM max hold.
- Added RSRP, RSRQ, SINR to scanner.
- Added TxTest measurement.
Fixed WiMAX Signal Analyzer
----------------------------------- No Changes.
Mobile WiMAX Signal Analyzer
----------------------------------- No Changes.
DMR 2 Analyzer
----------------------------------- Replaced graph based coverage mapping with map based coverage mapping.
PTC Analyzer
----------------------------------- Initial release.
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NBFM Analyzer
----------------------------------- Initial release.

What will the Customer See in this release? S412E Application Package V1.01 4-29-2011

General Features
---------------- Temperature reading in status window now displays both in Celsius and Fahrenheit.
- Touching parameters on the left column of screen activating for parameter editing.
- Preventing saved jpeg from including saveRecall window when the button ENTER is repeatedly pressed during save.
Vector Network Analyzer Application
----------------------------------- Application will now default into field mode for the S412E.
- Calibration type selection in field mode has been simplified to '1-Port' and '2-Port' calibrations.
- Added warning window when calibration is ON and the user attempts to set a frequency outside of the calibration frequency range.
- Scaling has been changed from 'Reference Value'/'Resolution Per Div' to 'Top'/'Bottom' in field mode.
- Dual graph display added in field mode.
- 'Dithering' has been renamed to 'RF Immunity' in field mode.
- 'IFBW' button has been removed in field mode.
High Accuracy Power Meter Application
------------------------------------No Changes.
Spectrum Analyzer Application
----------------------------------- Overhaul of the User Interface (see New Measurement Guide 10580-00244 for more details)
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- More setup information is now displayed on the left edge of the screen.
- Amplitude menu
- Reference Level Offset is now more consistent with 'Power Offset' used in other modes.
It now accepts 'Gain' or 'Loss' as terminators and the value is shared with other modes by default.
- BW menu
- RBW and VBW values are now maintained separately for zero-span measurements.
- The default value of Span/RBW is now 100.
- A new button to change VBW average type to Log.
- Marker menu
- A 'Large' setting is now available for the Marker table to view marker readout in a large font.
- Trace menu
- A new Trace Info button is now available in the Trace menu to show a concise listing of all parameters
for the selected trace.
- 'Reset Sweep' button has been renamed to 'Reset Trace' and moved to the Trace menu.
- Sweep menu
- 'Manual Trigger' is now called 'Sweep Once'.
- A new 'Sweep n Averages' button has been added to allow a full set of averages to sweep when the sweep
is set to Single.
- A new Sweep Mode button (only certain models) allows users to control the sweep algorithm.
- A new 'Auto Sweep Time' button has been added.
- Trigger sub-menu has been revamped with the ability to add hysteresis to the video trigger level.
- Gated Sweep Setup (Option 90) is now more responsive and has separate controls for the gate view (zero span).
- Improvements and bug fixes to the Field Strength measurement.
- In Coverage Mapping, user can now retrieve GPS altitude information via SCPI commands, and saved tab delimited and/or KML files.
- Added quick key access, and screen touch access to SPA measurement settings in Coverage Mapping.
- Added color legends for setting threshold levels in Coverage Mapping.
- Fixed units in RSSI Coverage Mapping.
- Added the display of frequency range in the antenna table.
- Added the display of a frequency offset.
- Added the display of Fahrenheit for temperature in the SelfTest window.
- Fixed display issues when switching from SPA to AM/FM/PM.
- Fixed problems in zero span where IF bandwidth appears different than what is set to.
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- Disabling of save-on-event in spa when switching to other spa submode, i.e. IA.
- Save/Recalling a saved trace with some ref level offset in MST.
Interference Analyzer Application
----------------------------------- Fixed a bug where the 'Save' window would also be saved when saving to jpeg from Spectrogram measurements.
- In Interference Mapping, user can now retrieve GPS altitude information via SCPI commands, and saved tab delimited and KML files.
- Timing accuracy of sweep interval of RSSI has been improved.

Channel Scanner Application
----------------------------------- Fixed several bugs related to Script Master.
- Fixed a frequency range discrepancy to the model frequency range.

AM-FM-PM Analyzer
----------------------------------- Fixed an issue with power offset.
- Added SCPI commands.
- Added coverage mapping.
Vector Volt Meter
----------------------------------- No Changes.
P25 Analyzer
----------------------------------- Added ability to adjust the NAC of the p25_1011 generator pattern.
- Added am_1khz_audio generator pattern. am_1khz_audio pattern percentage is adjustable.
- added fm_1khz_audio generator pattern. fm_1khz_audio pattern deviation is adjustable.
- Added ability to squelch the summary graph in the analyzer measurement type.
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- Added ability to change Rx units from dBm to Watts.
- Added ability to change Tx units from dBm to Volts.
- Added averaging for all summary window values except for 'NAC'.
NXDN Analyzer
----------------------------------- Added ability to adjust the RAN of the p25_1031_XXXX generator pattern (where XXXX is 9600 or 4800).
- Added am_1khz_audio generator pattern. am_1khz_audio pattern percentage is adjustable.
- Added fm_1khz_audio generator pattern. fm_1khz_audio pattern deviation is adjustable.
- Added ability to squelch the summary graph in the analyzer measurement type.
- Added ability to change Rx units from dBm to Watts.
- Added ability to change Tx units from dBm to Volts.
- Added averaging for all summary window values except for 'RAN'.
LTE Analyzer
----------------------------------- Fixed a bug with PBCH Power measurements where results were 6 dB higher when directly connected to a Transmitter.
Fixed WiMAX Signal Analyzer
----------------------------------- Initial Release.
Mobile WiMAX Signal Analyzer
----------------------------------- Initial Release.
DMR 2 Analyzer
----------------------------------- Initial Release.

General Caution
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---------------If an unintentional failure occurs during the firmware update process, recovery is possible using the Emergency Repair feature through a USB Host connection (i.e., a USB stick).
NOTE: Update is not required if V1.00 package is already installed in the unit.
NOTE: Please be careful to choose the correct model when upgrading firmware.
What will the Customer See in this release? S412E Application Package V1.00 10-11-2010

General Features
---------------Initial Release
Vector Network Analyzer Application
----------------------------------Initial Release.
High Accuracy Power Meter Application
------------------------------------Initial Release.
Spectrum Analyzer Application
----------------------------------Initial Release.
Interference Analyzer Application
----------------------------------Initial Release.

Channel Scanner Application
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Initial Release.

AM-FM-PM Analyzer
----------------------------------Initial Release.
Vector Volt Meter
----------------------------------Initial Release.
P25 Analyzer
----------------------------------Initial Release.
NXDN Analyzer
----------------------------------Initial Release.
LTE Analyzer
----------------------------------Initial Release.

Copyright© ANRITSU. All rights reserved.

